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1. Introduction

This document gives the guidance on how to test Quanta devices.

2. Test Environment

Quanta LM171/LM171G device supports Windows XP, Windows Vista (32 bit), and Windows 7 (32 bit)
operating system. It’s recommended to install Quanta LM171/LM171G software in Windows 7 32-bit OS.

2.1. Uninstallation

In order to install latest version of software, uninstallation of previous version is required, including
drivers, connection manager, and corresponding software tools.

2.1.1. Windows 7 (32 bit)

Altair Semiconductor

LTE ALT3100
Start->Programs—> Altair Semiconductor->LTE bl ADCC
ALT3100-> Uninstall (@) Connection Manager

#& DbgView

@ mMDM

@ Mseg\iew

(T Offline Logs Playback

[ smancU

Q Uninstall

HLVUSB

Internal Tools

1. Please click

“Altair LTE Pa ckags Uninstall ——

2.  Please click “Yes (Y)” button.

p -  Are you sure you want to completely remove Altair LTE Package
| ¥' and all of its components?
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Please click “Uninstall” button.

Please wait a few seconds to complete
uninstallation.

Version: 04.05.00.00.50.TF

Please click “Close” button.

Version: 04.05.00.00.55.TF

Please click “OK” button.

@ Altair LTE Package was successfully removed from your computer.

| Altair Semiconductor

Please click

Ji LTE ALT3100
“Start->Programs—>Altair Semiconductor->LTE . HLVUSB
ALT3100—>HLVUSB-> Uninstall”. Iﬂ Image Burn Tool

EE' Uninstall

Please click “YES (Y)” button. Windows I“ﬂﬂller‘.m

Please reboot your computer after you have
completed the uninstallation. i TR E R i A L

TRy | wmw |




2.2. Installation of drivers

2.2.1. Windows 7 (32 bit)

1. Please double clicks on “Altair(Quanta) Tool
Package v1.0.0.exe” to start installation.

2.  Please click “Next >” button.

3.  Please click “Install” button.

4. It will take a few minutes to complete
installation.

5. Please click “Next >” button.

Welcome to the InstallShield Wizard for
Altair(Quanta) Tool Package v1.0.0

The InstallShield{R) Wizard will install Altair(Quanta) Tool
Package v1.0.0 on your computer. To continue, dick Mext.

WARNING: This program is protected by copyright law and
international treaties.

< Ea.;k__‘l[ Next = j [ Cancel

Ready to Install the Program
The wizard is ready to begin instaliation.

Click Install to begin the installation,

If you want to review or change any of your installation settings, dick Back, Click Cancel to
exit the wizard.

Installshield

Welcome fo Altair LTE Package setup wizard

Version: 04.05.00.00.55.TF
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10.

Please check “l accept the terms in the license
agreement”.

Please click “Next >” button.

Please select “Full Installation” type.

Please click “Next >” button.

Please click “Next >” button.

Altair Semiconductor Ltd. F,
Click-wrap Agreement [

IMPORTANT - YOU MUST READ THESE TERMS AND
(CONDITIONS CAREFULLY BEFORE INSTALLING OR
[USING THE ALTAIR SEMICONDUCTOR LTD. ("ALTAIR™)
SOFTWARE ("SOFTWARE"). BY CHECKING ‘T AGREE.”
'YOU ACKNOWLEDGE THAT YOU HAVE READ THIS END
[USER. LICENSE AGREEMENT ("EULA”). UNDERSTAND IT.
AND AGREE TO BE BOUND BY ITS TERMS. THISEULAIS A
LEGALLY BINDING CONTRACT. NO DIFFERENT THAN A -

Version: 04.05.00.00.55.TF

UE Drivers

Connection Manager
Connection Manager Application
Developer Mode

Debugging Toals

Third Party Installations

Version: 04.05.00.00.55.TF

Choose Install Location
c i

\Program Files\Altair S ductor\ALT3100

Version: 04.05.00.00.55.TF
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11. Please click “Install” button.

Version: 04.05.00.00.55.TF

12. Please click “Next >” button. e G

l

Version: 04.05.00.00.55.TF

13. Please click “Finish” button. Rl G

The seiup process has

Version: 04.05.00.00.55.TF
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14. Please click “Next >” button.

15.

16. Please click “Next >” button.

17.

Please check “l accept the terms in the license

agreement”.

Please click “Install” button.

| ) Alsir HLVUSB

Welcome to the InstallShield Wizard for Altair
HLVUSB

| The InstallShield{R) Wizard will install Altair HLYUSE on your

computer. To continue, dick Mext,

WARNING: This program is protected by copyright law and
international treaties.

Please read the following license agreement carefully.

Altair Semiconductor Ltd.
Click-wrap Agreement

IMPORTANT - YOU MUST READ THESE TERMS AND
CONDITIONS CAREFULLY BEFORE INSTALLING OR USING
THE ALTAIR SEMICONDUCTOR LTD. ("ALTAIR") SOFTWARE
("SOFTWARE"). BY CHECKING T AGREE™ 7YOU
ACKNOWLEDGE THAT YOU HAVE READ THIS END USER ~

@) T accept the terms in the license agreement!
("I do not accept the terms in the ficense agreement

Installshield

<Back |

Ready to Install the Program
The wizard is ready to begin installation.

Click Install to begin the installation,

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

Installshield
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18. Please click “Continue to install driver anyway

(1.

19. Please click “Continue to install driver anyway

(y”.

20. Please click “Continue to install driver anyway

(1.

21. Please click “Continue to install driver anyway

(y”.

22. Please un-check “Launch “Hostless Image

> FRELBHEANEN)
3 TSRS TN SRR EN TSN EHEY e

> IRZRILESHELTREQD
CREEEE TR N ETEC T A FNENESNE - RESY
AENFEERETE N ISR ENESHERTNEASS -

(v) ESEE8=HD)

Burn””

23. Please click “Finish” button to complete driver The InstalShisld Wizard has succassfully installed Altsir
. . HLWLUSE. Click Finish to exit the wizard.
installation.

[] Launch "Hostless Image Burn®

Cancel |

24. Please click “OK” button.

25. Please click “Finish” button.

The InstallShield Wizard has successfully installed
Altair(Quanta) Tool Package v1.0.0. Click Finish to exit the
wizard.

Page 9



27.

28.

[ sse=sm=s ==
26. Please plug in Quanta device and please be \ﬁ N
. . . EERIEREETE LI
patient and wait a few minutes to complete
: P P Gadget Serial (COM111) H==cup
driver installation. Multifunction Gadget with multiple  CEER
configurations
Please click “Close (C)" button. Remote NDIS based Internet Sharing  SEER
Device #4
Gadget Serial (COM112) « CEER
Please reset Quanta device (take out and plug in
the usb cable), it will take about 50 seconds for
Quanta embedded system to be ready. FE)
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3. Operation of Connection Manager

3.1. Windows 7 (32 bit)

5.

6.

3.1.1. Basic Configuration

In order to get information from our
embedded connection manager, it’s
mandatory to configure as the following
instructions.

Please click

Start=>Programs—> Altair Semiconductor=>LTE
ALT3100->Connection Manager.

Please right click on top of connection manager
and select

Options—>Device Location>Technician PC.

Connection manager will pop out window for
you to enter IP and port.

Please enter IP address “10.0.0.1”. (see NOTE)

Please click “OK” button.

NOTE: If you have successfully installed Quanta
LM171/LM171G device, the embedded module will
generate DHCP server and its IP address is
“10.0.0.1”. Meanwhile, our Quanta device will get a
DHCP address “10.0.0.133” automatically.

| Altair Semiconductor
LTE ALT3100G
el ADMCC

@ Connection Manager

ﬁ Db :g"'.-"iew

a MO

@ MsgWiew

(@) Offline Logs Playback

B smartcu

£} Uninstall
) HLWVUSE

Internal Tools

@) LTE - Local

e
View

SIM Stat
Device N|
Automati

Manual PLMN

Change to Commercial Mode

»

Options

Connectio:

Help
Reset

Quit

0dBm

AR |

Disable Polling
PIN Management

annect Mode

» |[v] Local

Open Platform

Technician PC

Enable Remote Support
Multiple UEs
Android Tablet

.
Enter IP and port

=)

Enter [P and port for remote dewvice:

IF 10001

Port 5555

0K | |

Cancel

b
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i 3 z
7.  Please check if connection manager shows Q) LTE- Jechnidias 65 @ﬁlﬁ
device information correctly and the red Altair — ’
logo turns into yellow color. I b ad
— Service Area Not Valid
| Automatic PLMN selection l
= Connect

| Connection Time: 00-00-00-00

alcair

somicondudtor
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1.

3.1.2. Extended Information

Please right click on top of connection manager
and select

View—>Extended Information.

Connection manager will pop out “Extended
Information” window.

It’s NOT mandatory to set up this
“Configuration” tab, connection manager will
scan all the supported frequency bands and try
to connect to the network.

@ Lm_Tecmn%zd@&W‘
- |— View 3 || Extended Information
SIM Manual PLMMN LTE Manager
Sery Change to Commercial Mode
Autc i
Options 3
Help »
Reset
Con
Quit
0dB alGair

semiconductar

oo T

fConflgnration | Extended Deta. | 4t Commands|

[¥] Execute Pre Connect Letions:
Pre Connect Actions:

DL EARFCN: 5230
DL Frequency:  751.0 Mhz
Eand: 13
() Mone
@ Only Set EARFCN
Oy R Seript
EARFCH and Seript
AP #1 Settings: —
[ spn #1: 12 | |default
[ Authentication:

[7] Authentication Host Naime:

AP #2 Sethings: R
[] apn #2: TP = | |defualt

[T Authentication:
[T Authentication Host Haime:

[7] Turn On Bignal Strength Sounds
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The “Extended Data” tab shows information of
Connection Status, APN, Transmission mode,
Bandwidth, DL EARFCN, Band, PLMN and
Physical Cell ID and so on.

The “At Commands” tab will allow you to send
AT Commands sets to configure supported
functional parameters or to get supported
information you want.

Configuration E:-:ten::ledData| At Cnnmmldsl

Information
Connection Status:

#apr: 1 = FV4:
IFVE:

AFN:

Transmission mode:

Band Width:

DL EARFCH:

DL Frequency:

Band:

PLMN:

Phyrsiral Cell ID:

RERE:

RERQ:

SINE:

Connection Time:

B rtivity

Ciperator Limdtation:

BT Rate:

Received Sent:

Not connected

e 0bp/c) DL: dbp/c UL: Sb'c.

AT Command Pane

| Contiguration | Extended Data | At Commands |

]
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3.1.3. LTE Manager

Please right click on top of connection manager
and select

View—>LTE Manager.

Connection manager will pop out a “Supervisor
Password” window.

Please input “123456” and click “OK” button.

It will pop out a “LTE Manager” window.

LTE Manager shows information about
Generallnfo, LogCreator, Dispatcher, Relay, and
GPS Tool.

"6 LTE - Technician PC e ]

| View » Extended Information
SIM i
Manual PLMN !
- ' - LTE Manager
A ic PLM Change to Commercial Mode

Options 4
Co
Help »
Connection Time Reset

Quit

alb orr

samicondu

0dB

clor

Pazzword iz required o perform this operation:

ook

LTE Manager

Generallnfo || LogzCreator | Dispatcher | Relay | GPS Tacl)

[101/9/20 T 0226:01]  Initislizing Device To TechnitionPC Mode
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3.1.4. Manual PLMN

Please right click on top of connection manager _ PR i
and select ]| SiMinserted | Manual PLMMN
Manual PLMN | Service Area Change to Commercial Mode
’ Automatic PLI ;
— Options
Connection manager will pop out a “PImn
” . S— Ce HE'FI
Search” window.
7 : Reset
—  Connection Time
|_| Quit
0dB alcair
somiconductor

-

It’s not necessary for you to select PLMIN Plrn Search i m
manually if you want to connect to network.

i
i

".J': I 1.\'\

Select | Cancel
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4.

3.1.5. Change to Commercial Mode
Please right click on top of connection manager
and select

“Change to Commercial Mode”.

Connection manager will pop out a “User Mode
Changed” dialog.

Please click “YES (Y)” button.

Please wait a few seconds for device to be
ready.

Gl o 1 o 1
@) LiE—TBchnlcmn_P i i
1 SIM inserted Manual PLIMN
e | Change to Commercial Mode
Automatic PL Options b
Ci Help >
Reset
—  Connection Tim Quit

alcair

sumiconduclar

= = F =1
User Mode ChangEdI lﬂ

Card must be restarted to complete transition.

Do you wish to restart card?
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3.1.6. Disable Polling

Please right click on top of connection manager
and select

“Options—=>Disable Polling”.

Connection manager will stop searching for
available network.

{€) LTE - Techniciany View
Manual PLMN
SIM insert
. i Change to Commercial Mode
Service Arg -
’ 5 ‘ Options Disable Polling
Help PIN Management
Reset Automatic Connect Mode
Connection T: Quit Open Mew RE
: Device Location
alGair
0dB semiconductor
|5 — — — Upgrade Image...
-
Device Mode
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3.1.7. PIN Management

Please right click on top of connection manager
and select

“Options=>PIN Management—>PIN Information”

to get PIN information.

Connection manager will pop out “PIN
Information” window.

Please click “OK” button.

You also can enable PIN usage by right click on
top of connection manager and select

“Options=>PIN Management—>Enable PIN
Usage”.

Please input correct PIN code and click “OK”
button.

P

(@) LTE - Techr=

View

SIMi Manual PLMN
Servi Change to Commercial Made
Sdo Options 3 Disable Polling
E Help v | PINManagement v BN blormation
-] Reset Automatic Connect Mode f”ﬂb‘erF‘IN Usage
Quit Open New RE Enter PIN Code
alcair Device Location » Change PIN Cede
Sanicbadustor
Upgrade Image...
Device Mode »

PIM retry counter: 3

PUK retry counter: 10

LTE - Technician

1 i

PIM i= not in use.

View

SIM i ed Manual PLMN
Service Area|

Change to Commercial Mode

Automatic PL‘ Options.

q Heb
Reset

ComtionTi i

» Disable Polling

» I e r PIN Information
Automatic Connect Mode Enable PIN Usage
Open Mew RE Enter PIN Code

- Change PIN Code

Device Location »
Upgrade Image.
Device Mode 3

- — T B
Please Enter PIN Code ﬂ

-

PIN iz cwrently lncked
Enter a 4-8 digits for the 31k PIN
Remaining retries; 3

PIN Code ok

OK || Comcel |
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3.1.8. Automatic Connect Mode

Please right click on top of connection manager
and select

“Options=>Automatic Connect Mode” to switch
connection manager from manual connect
mode to automatic connect mode.

Connection manager will automatically connect
to network.

(@) LTE - Technician |"_"'|_'_"| o]
View 3
SIM inserted Manual PLMMN
Service Area Change to Commercial Mode
Automatic PL Options ' ‘
C Help 3
Reset
Connection Ting 5
Quit

Disable Palling
PIN Management

Automatic Connect Mode

0dB alt

air
SaMibEAdE ST I

Open New RB
Device Location

Upgrade Image...

Device Mode
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3.1.9. Device Location

For Quanta hostless device, please use
“Technician PC” only.

Please right click on top of connection manager
and select

“Options—>Device Location—>Technician PC”.

Please set IP address to “10.0.0.1” and click
“OK” button.

Connection manager will get information from
Quanta hostless device.

@) LTE - Techniciar P =S =)

View v

SIM inserte] Manual PLMN

Service A Change to Commercial Mode

Automati =

e Options » Disable Palling

Help 5 PIN Management

Em—— Reset [¥] Automatic Connect Mode
Quit Open New RB

048 ggeare ’]' Device Location

Local

Upgrade Image...
Device Mode

Open Platform

. Technician PC(10.0.0.1)

Enable Remote Support
Multiple UEs

Android Tablet
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3.1.10. Help

. . . : @ LTE - Technician P l \L BN |

Please right click on top of connection manager — iew N
SIM inserted Manual PLMMN
and SeIeCt Service Area Change to Commercial Mode
“ ” Automatic PL Options g
Help~>About”.
0| Help r About

H H Reset Sh [

Connection manager will pop out a “LTE Card ComectionTin (. o eesions

Info” message box. albair

semicandustor

0dB

It will show information of IMSI nhumber, IMEI
number, Supported Bands, Current firmware

. . @l IMSInumber 001010123456063
version, and System package version. )
~ IMEnumber 000000000000000
Please click “OK” button.
Supported Bands: 13

Current firmware version ALT3100_04 05_00_00.50_TF

System package version: 04.05.00.00.50.TF

. . . | @ LTE - Technician . \-’Iie.w ST ;
Please right click on top of connection manager | = |
SIM inserted Manual PLIMIM
and SeleCt s e Change to Commercial Mode
Automatic PL Options »
“" H ”
Help—=>Show Versions”. A Fee S A
. . y . Reset Show Versions
Connection manager will pop out a “Version Connection Tim ¢3¢

info” message box.

alcair

semiconductor

TR System release version: 04.05.00.00.50.TF

"

It will show information of System release
version, SWinfra release version, and Current
firmware version.

SWinfra release version: 2012-07-10

Please click “OK” button.
Current firmware version: ALT3100_04 05_00 0D S0 TF
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3.1.11. Reset

' = = —. i .Ez "

Please right click on top of connection manager (@) LTE - Technician e View

and select — Manual PLMN

“Reset”. — Device Mot Fo Change to Commercial Mode
L] Automatic PLP Options

. . oun
Eonnectlon manager will pop out a “” message B & Help
OX. ] Reset

—{  Connection Time Quit
gt alair

semiconducltor
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4. Diagnostic Tool

4.1. MsgView

1. Please open MsgView by clicking

Start—>Programs—> Altair Semiconductor>LTE
ALT3100>MsgView.

2.  Please click “Start Logging” button to start
message logging.

3. Please plug in Quanta device and wait a few
seconds for device to be ready.

4.  Once you find an issue, please stop testing and
data logging, please save log file and send it to
Quanta.

Altair Semiconductor
b, LTEALT2100
b ADCC

(@) Connection Manager
#& DbgView
@ MDM

M| MsgView

(T Offline Logs Playback
B smancu
£} Uninstall
|| HLVUSE

| Internal Tools

[[| Message Logging

12815 Jogfilog”

Timestamp L1A  MAC ~ RLC PDCP RRC/PDM NAS

<

RRC/NAS PDUS | System POUs|

1€ o I e N M FSN R P T
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4.2. DbgView

Altair Semiconductor

LTE ALT3100
Start=>Programs—> Altair Semiconductor=>LTE bl ABCC
ALT3100->DbgView. (@ Connection Manager

PE e Dl::ug‘-.l’lew

@ MDM

@ MsgView

(T Offline Logs Playback

B smartcu

£} Uninstall

HLWVILISE

Internal Tools

1. Please open DbgView by clicking

;xDebugv\ewun\wwfmi;g?(@uu"t -: cadind f E TN '/“cr\@-ﬂﬁ
. . . File Edit Capture Options Computer Hel
2. Please plug in Quanta device and wait a few TR R T
Seconds for dEVice to be ready’ and the l:n i‘[:llﬂﬂ E::;‘gl?::;ﬂ3ml 127001 , UMAC, 2104626409, DEBUG ," AToomlnandrﬁfENEd arrayInden=59" , at_cmd_parser.c, 184 i
Db V, 'II t t d t I . {% i;ﬂg{gi g% 1343303391 1270041, UMAC 2104626561 , INFO | * AT command res
gView will start data logging. 09 ERUINI [

o B 113131 [5796] OK
105 B4 113131 4796] ", at_cnd_handlecs.c , 652

106 fj;ll}lﬂ 3 75] 1348303091 1220011 , UMAC, 2109105668 , INFO AT command reefved - AT", at_fsm_handlers ¢, 97
H “« ” H 107 11:31:31 4796] 1348803091 127001, UMAC, 2100106083 , INFO _" AT comnand response
3.  Pleaseclick “Save” button to save log to a file.  [& ®fui5 o

I 18 LB 113131 4796] a\ cd_handlecs.c , 652
10 k4113131 3 75] 1348303091,117.001,UMAC,ZICQBSEW INFO ,"AT command recetved - ATHOFUNT | at_fsm_handlers ¢, 97
UL B3 3796] 1343808001 | 127.00.1 ; UMAC, 2106256450, DEBUG," AT comumand received: arraylnden=35" , at_cmdl_pamser.c, 184
12 k113131 [4796] 1348805001 , 127.00.1 , UMAC, 2109257102, INFO | ATOOmmandrESpOnSE
+CFUN: 1

4.  Once you find any issue, please stop testing and ||iii Tziis ]

114 [8796] OK
. . . 115 i;ll?lﬁl (4796] *, at_cmd_handlecs.c, 652

116 113131 B 796) 1348303091 127001 L UMAC, 2100405998 , INFO ,"AT oommand revetved - ATHCREG?" | at_fsm_handlers ¢ | 97

data Iogglngl and please send thls Iog flle to 17 LB L1313 3796] 1343808001 | 127.00.1 , UMAC, 2100406160 DEBUG," AT comumand received: arraylnden=13" , at_cmd_pamser.c, 184
18 k4113131 [796] 1348800001 , 127.001 , UMAC 21094%763,ENFD AToommanrl:esp&nsE

Q t 18 113131 3796] +CREG: 00

uan a- 120 k4113131 B 796)

121 B 13 4796] OK
122 k113131 [379€] ", at_crnd_handles.c, €52

123 L1313 4796] 1348303091 127000, UMAC, 2100602330, IMFO AToommandreczwed ATHOSATT? , at fsm_handles ¢, 97
124 k113131 5796] 1348805001 , 127.00.1 , UMAC, 2109602638, DEBUG,," AT ctrmand array Index= a7 Lat Dmd_parSE(C 184

125 L1313 3796] 1343808001 | 127.00.1 , UMAC, 2100602683 | DEBUG * Handl\ngOGA'lTExecOReadl Test0°, ot cond handlersc, 4510 |-
126 k4113131 [3796] 1348800001 , 127.00.1 , UMAC, 2100603142, INFO | * AT command res TESpOnSE F
127 L1313 3796] +0GATT. 0

| 128 R4 113131 [5796] OK

128 L1313 4796] " , at_codd_handlecs.c, 652

« i »
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5. Firmware Upgrade

5.1. Image Burn Tool

1. Please click

Start—>Programs—> Altair Semiconductor>LTE
ALT3100>HLVUSB->Image Burn Tool.

2.  Please check “U-Boot Env”.
3.  Please check “U-Boot”.

4. Please check “Linux”.

5. Please check “File System”.
6. Please check “NVM”.

7. Please click “Start” button to start firmware
upgrade process.

8.  Please click “YES (Y)” button.

Altair Semiconductor
LTE ALT3100
R ADCC
(@ Connection Manager
#%& DbgView
& MDM
@ Msg\fiew
(@) Offline Logs Playback
B smarcU
Ch Uninstall
HLYUISE
[®7 Image Burn Toal
i Uninstall

Internal Tools

i Image Burn Tool

Choose what to burn on the device and press Start.
Output is in the console window.

¥ U-Boot Env

[Using Default Image

¥ U-Boot

lUsing Default Image

W Linux

[using Default Image

¥ File System

[Using Default Image E
¥ NVM - WARNING! This will overwrite the BSP files!
|Using Default Image EI

f - j, ATTENTION: "LTE Manager” and/or "Connection Manager" are
¥ currently running.

These processes will be closed.
Continue?
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10.

11.

12.

13.

14.

15.

It will show message “Waiting for device
reset...”.

The easiest way to reset device is to power cycle
device (i.e. to take out and plug in device).

If you are doing remote firmware upgrade
process, please follow the following procedure
to reset device.

Please open device manager and find network
interface of Quanta device “Remote NDIS based
Internet Sharing Device #”.

Please disable this network interface by right
click oniit.

Please enable this device again.

Please find your Gadget Serial COM port
number (for example, COM112).

¥ Image Burn Tool

Waiting for device reset...

\theros ARSBY3 Wireless Network Adapter
\theros AR8151 PCI-E Gigabit Ethemet Controller

ficrasoft Virtual WiFi Miniport Adapter
Remote NDIS based Internet Sharing Device #4
CWALL Virtual NIC

A SmEE . - = f e Bl e wmme s ! mEm
RO RIW WAY REH

s 2B 0 HE = F&s

: e

theros ARSB93 Wireless Network Adapter
theros AR8151 PCI-E Gigabit Ethernet Controller
& Microsoft Virtual WiFi Miniport Adapter

=¥ Remote NDIS based Internet Sharing Device #4
onicWALL Virtual NIC
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16.

17.

18.

19.

20.

21.

22.

23.

24,

25.

26.

Please open COM112 COM port (for example,
open it by putty.exe)

Please select “Serial” as your “Connection type”

Please fill in “COM112” as your “Serial line”.

Please click “Open” button to set up
connection.

Please enter “at”.
Please check if it responds with “OK”.

Please enter “atz” AT command to reboot
Quanta device.

After Quanta device reboots successfully, the
“Image Burn Tool” will start to do firmware
upgrade process.

Please make sure you Quanta device has
finished the firmware upgrade process with “----
Finished ----“.

Please close “Image Burn Tool”.

Please take out and plug in Quanta device.

i —
PuTTY Configurati . X
ﬁ u Conhguration - . L
Cateqary:
[ —J--Session Basic options for your PuTTY session
: T: B Fog?ing Specify the destination you want to connect to
emmingl ol
Heyhirard Serial line Speed
- Bell COM112 5600
P Features Connection type:
Window Raw (7 Telnet Rlogin S55H @ Sedal
. }“ppea@nce Load, save or delete & stored session
- Behaviour
- Translation Saved Sessions
- Selection
.+ Colours [ Defaut Setings | i
—I- Connection WCDMA, e
- Data | Save |
Prowy
Telnet | Delete |
Rlogin
| #- S5H
| Seriel Close window on exit:
1 Mlways Mewver @' Only on clean exit
| About Open | l Cancel |
&3 COM112 - PuTTY e =

# | Image Bum Tool

- Dane.

- Done.

Read: "Erased=sectors=<H" with
- Dane.
- Done.

Read: "Copy to Flash..
- Dane.

Write: protect on all
- Done.

- Done.

-—- Finished —-—-—

Urite: erase heB90BBA heBeffff

Write: cp.b $loadaddr heB90080 $filesize

- donext" with

Read: "Protect Flash Bank=*H#" with timeout 28

(S

=]

timeout 360

timeout 368
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27.

28.

29.

30.

31.

32.

33.

34.

35.

In order to recover the original calibration data,
please use ADCC tool.

After the device reboot successfully, please
open “Altair Device Control Center” by clicking,
Start—>Programs—> Altair Semiconductor>LTE
ALT3100—>ADCC.

Please click “Open Connection” and wait for a
few minutes.

Please click “BSP DB” tab.

Please select “Boot Parameters (Boot Bp).
Please select “From File”.

Please click Read DB and find the source DB and
click “Open” button to read it.

Please click “Burn DB” button to start burning.

Please repeat this procedure to burn the other
DBs.

"t Alair Device Comol contort I -

i Open Connection ¥ Reset 4 Rx Graphs. ) Get Versions =] Quit
|Basic. [LTE DX/RX|BSP DB MET [Fw Upgrad
BSP DB
DB Seleclion: |Boot Parameters (BootBp) _ BSP Files List
- — Type: |
Value:|
Set
= - Get Files List
Create Metadata
Template Delete File
Variable Properties
= 1
Description:
| ReadpB | Bum DB Create DB
@ From Device — ]
= DB to Fil
i Close DB Export DB o File i

¥ Trying to Connect. C—— Ver. 04.05.00.00.50.TF

¥ Close Connection | * @ Reset il Rx Graphs i Get Versions =] Quit
|Basic. [LTE X/RX| 8P DB |MET [FW Upgrade
\|||| BspDB
DB Selection: [Bool Parameters (BootBp) - ~ BSPFleslist
Type: |
[z}- Boot Parameters. Nk
St
o Woms | | |LSetFlestat ]
Template Delete File
Variable Properties
F ]
Description
Bum 0B Crente 0B
©) From Device — |
= Export DB to Fil
@ [From File Gosa it | it Y
@ Connected ‘Connected successfully Ver. 04.05.00.00.50.TF
o) Al Davice Contiol Crotes ol ot
¥ Close Connection (@ Reset wjf RxGraphs. & Get Versions =] Quit
\Basic |LTE T/RX| BSP DB MEI |FW Upgrade)
| BSP DB
| DB Selection: [Bool Parameters (BootBp) - _ BSP Files List
Type: |
I-- Boot Parameters Value I
v -
wvl Set
e
Template Delete File
Variable Properties
Range: -
B Vanable metadata does not exist -
[Cheits o Goste 08
© From Device
= Export DB to Filk
Pt [ Close DB | [ o Rle B
@ Connected. Ver. 04.05.00.00.50.TF
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6. OMA-DM

6.1. Mandatory Configuration

6.

7.

It’s necessary to configure Quanta device with
the following parameters before you start
OMA-DM testing.

It’s mandatory to configure Quanta device
with the following parameters if your device is
upgraded to new firmware.

Please make sure that the device is not
connected to LTE network (i.e. offline from
eNodeB) before you do any configuration.

Please open connection manager.

Please enter the following AT commands
sequentially (Please refer section 3.1.2).

AT%SETCFG="enable_test_mode","0"

AT%SETCFG="vzw_mode","1"

AT%SETACFG=ecm.Mode.VzwMode,true

AT%SETACFG=ecm.Mode.VzwIimsTestMode,false
Please check if it returns “OK”".

Please confirm your configuration by entering
the following AT commands sequentially.

AT%GETCFG="enable_test_mode"

(it shall be “0”)

AT%GETCFG="vzw_mode"

(it shall be “1”)
AT%GETACFG=ecm.Mode.VzwMode

(it shall be “true”)
AT%GETACFG=ecm.Mode.VzwimsTestMode

(it shall be “false”)

Extended Infarmation
e

| Configuration | Extended Data | 4t Commands

AT Command Pane

BI%T%SETCFGﬁ'emble_test_mode g

= ATHRETCEFG="vaw_mode","1"
0K

= ATFSETACF =ecm Mode Vewbode, true

[0):4

= ATHEETACF =ecm Mode VewlmsTestblod e, fale
[0):4

= ATHRIETCRG="enable_test_mode"

1]

i [0]:4

= ATHIETCEG="vaw_mode"

1

Il |ox

> ATRGETACFG=ecm Mode Vawhode
te

QK

= L TRGETACFG=cm Mode VawlmsTesthdode
b

m

Send
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6.2. How to Enable/Disable APN

1.

+ Telnet 10.0.0.1

Please make sure your device has disconnected
from network.

If you would like to edit APN table, it’s
necessary to telnet to embedded connection
manager. (Please refer to section 3.1.1)

Please open command console.
Please key in “telnet 10.0.0.1” and press enter.

If you failed to telnet 10.0.0.1, please manually
set your IP address to 10.0.0.133.

w i N - =
After successfully telnet to 10.0.0.1, please key | REEUETZIIIEEE

in “cat /etc/config/APNTable” and press enter. ig PN " Classl’
i Name *UZWIMS’
. . IP_Type "IPU4UB’
There are 4 APNs in table, and you can see its fon Enabled *crue”
configurations, including NAME, IP_Type, e e e ablod * false
P_CSCF and so on. onfig PDN *Classz’

option Class 2

option Name ‘UZWADMIN’

option IP_Type "IPU4UG’

option Enabled "true’

option P_GSCF

option External ’false’

option AutoRecoveryDisabled ’true’

config PDN ‘Class3’
option Class 3
option Name ‘UZWINTERNEI’
option IP_Type "IPU4UGR’
option Enabled "true’
P_GSCF

El Telnet 10001

For example, if you would like to disable
“VZWIMS” APN, please use the editor tool “vi”
to edit this APNTable.

l # vi etcsconfigs/APNTahle

Therefore, please key in

“vi fetc/config/APNTable” and press enter.
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10.

11.

12.

13.

14.

15.

16.

Please move cursor to
Option Enabled “true”
Please modify this value to “false”.

NOTE: If you are not familiar with vi
commands, please refer to section 6.6 for
more information.

Please enter “Shift+z” twice to save file.

Please key in

“cat /etc/config/APNTable” and press enter.
Please check if “VZWIMS” APN is disabled.
Option Enabled ‘false’

Please enter “reboot” command to reboot
device in order to take effect of the
configuration.

You can also follow above procedures to
enable/disable other APNs.

NOTE: Please make sure to reboot device in
order to take effect of your setting.

BN Telnet 100.01 | |
| # cat etc/configsAPNTable

conf ig PDN ’Classi’
option Class 1
option Hame ‘UZWIMS’
option IP_Type *IPU4U6”*
option Enabled ’false’
option P_CSCF 1
option External 'false’
option AutoRecoveryDisabled *false”’

config PDN ’'Class2’
option Class 2
option Mame *UZWADMIN‘
option IP_Type *I[PU4U6°
option Enabled ’true’
option P_CSCF @
option External 'false’
option AutoRecoveryDisabled *true’

iconfig PDN ’Class3’
option Class 3
option Mame *UZWINTERNET*
option IP_Type *IPU4U6*
option Enabled *true’
option P_CSCF 8@
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6.3. How to Modify OMA-DM Server URL

1. Please make sure your device has disconnected
from network.

2. If you would like to edit OMA-DM server URL,
it’s necessary to telnet to embedded connection
manager. (Please refer to section 3.1.1)

3. Please open command console.
4. Please key in “telnet 10.0.0.1” and press enter.

5. If you failed to telnet 10.0.0.1, please manually
set your IP address to 10.0.0.133.

6. Please key in

“vi etc/config/service” and press enter.
7. Please modify the server URL to
"ivzwmdmii.iot.motive.com”
8.  Please enter “Shift+z” twice to save file.

9. Please key in “cat /etc/config/service” and
check if the server URL is set up correctly.

10. Please key in

“vi etc/config/vdmc/tree-motive.xml”

and press enter.
11. Please key in “/https” to search the server URL.
12. Please modify the server URL to

https://ivzwmdmii.iot.motive.com/southbound-con

nector/dm

el

B Telnet100.0.1

# # vi setcsconfigrservice,

S Telnet 100.0.1 = | B

config InitScript ECM
option Enabled ’true’
option APNTableFile 'APNTabhle’
option DebugLevel @

config InitScript UDMC
option Enabhled "true’
option ConfigFile ’/etc/config-vdmnc vdnc.conf’
aption DebugLeuvel 'none’
option DmServerUrl *ivzwmdmii.iot.motive.com’

cunfig InitScript CAT
option Enabled "true’

etcsconfig/service 11-1% 73x

B8 Telnet 10.0.0.1 =

{gets»
{leaf>
<name>Addr< name>
{get ><replaces>
LEarmatdchnd AFomnat
{yalue>https://ivzundmii.iot .motive.con/southbound—connector/dn{/value>
</leats
{leaf>
<name>AddrT ype</nane >
{get-/><replace/>
{format>chr{/format>
{value>URI< value>
<sleaf >
{leaf>
<{name>Port<{ name>
{get ><replaces>
£Eanmatdehul Eounaty
<value>443<{ value>
</leab >
<s/node>
{leaf>
<name>AfuthPref</name>
{get-><{replacer>
{format>chel{ format>
<value>syncnl:auth-nd5< value>
<sleaf>
— etcsconfigsvdmc/tree—motive.xml 67-428 15z
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13. Please also check if port number is “443”.

14. Please enter “Shift+z” twice to save file.
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Please check if your device has connected to LTE
network successfully.

If you would like to online enable/disable
“INTERNET” APN (see NOTE), it’s necessary to
enter specific AT command.

NOTE: Online enable/disable “INTERNET” APN
means it’s not mandatory to reboot device to
take effect of “INTERNET” APN. Please note
that this method is applicable to “INTERNET”
APN only, and this configuration will be lost
after device reboots.

If you enter “at%dpdnact=0" to disable
“INTERNET” APN, the LTE connection will be
lost. On the contrary, if you enter
“at%dpdnact=1" to enable “INTERNET” APN,
device will reconnect to LTE network.

6.4. How to Online Enable/Disable Internet APN

-
Extended Information

= atfdpdnact=l]
0K

atfd pdnact=1|

Send
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6.5. How to Enable/Disable OMA-DM log

1. Please make sure your device has disconnected
from network.

2. If you would like to enable/disable OMA-DM
log, it’s necessary to telnet to embedded
connection manager. (Please refer to section
3.1.1)

3. Please open command console.
4. Please key in “telnet 10.0.0.1” and press enter.

5. If you failed to telnet 10.0.0.1, please manually
set your IP address to 10.0.0.133.

6. Please key in
“vi etc/config/service” and press enter.

7. Please modify the value of Debuglevel to
“debug”.

8. Please enter “Shift+z” twice to save file.

9. Please enter “reboot” command to reboot
device.

10. Please enter “cat /tmp/vdm.log” and check

OMA-DM logs.

el Eh

B Telnet100.0.1

# # vi setcsconfigrservice,

B8 Telnet 10.0.0.1 . =

config InitScript ECH
option Enabled "true’
option APNTableFile *APHTable’
option DebugLevel B

config InitSceipt UDMC
option Enabled "true’
option ConfigFile '/etc/configsudmcsudmec.conf’
option DebuglLevel 'debug’
option DmServerUrl “https://ivzumdmii.iot.motive.com/southbound-connecta

config InitScript CAT
option Enabled ’true’

setc/configs/service [Modified] 1815 66x%

B8 Telnet 10.0.0.1

# # cat stnprudn.log

LOGGER INITIALIZED

Wed Dec 31 17:80:21 1969 <283> escoressrcsudm_api.c. 28%: [Core_MsgQl UDM_creat|

42: [DMC] Parsing conmand]
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6.6. How to Use VI editor

Please google search “vi manual” or by clicking below URL directly.
http://glaciated.org/vi/

FCC Regulations:

®This device complies with part 15 of the FCC Rul&gperation is subject to the following two
conditions: (1) This device may not cause harmfiérference, and (2) this device must accept any
interference received, including interference thay cause undesired operation.

®This device has been tested and found to comply thi limits for a Class B digital device, pursumt
Part 15 of the FCC Rules. These limits are desigoneprovide reasonable protection against harmful
interference in a residential installation. Thisipgent generates, uses and can radiated radioeiney
energy and, if not installed and used in accordavittethe instructions, may cause harmful intenfieesto
radio communications. However, there is no guamtiat interference will not occur in a particular
installation If this equipment does cause harmitdriference to radio or television reception, whaah be
determined by turning the equipment off and on,uer is encouraged to try to correct the interfeedoy
one or more of the following measures:

-Reorient or relocate the receiving antenna.

-Increase the separation between the equipmentaed/er.

-Connect the equipment into an outlet on a cirdiffierent from that to which the receiver is conteec
-Consult the dealer or an experienced radio/TVr&thn for help.

Changes or modifications not expressly approvethbyparty responsible for compliance could void the
user's authority to operate the equipment.

» RF Exposure I nformation

This Modular Approval is limited to OEM installatiofor mobile and fixed applications only. The
antenna installation and operating configuratidhnhis transmitter, including any applicable soubased
time-averaging duty factor, antenna gain and cdbss must satisfy MPE categorical Exclusion
Requirements of §2.1091.

The antenna(s) used for this transmitter must bialied to provide a separation distance of at 2asm
from all persons, must not be collocated or opegaith conjunction with any other antenna or trartami
except in accordance with FCC multi-transmitterdoict procedures.

The end user has no manual instructions to rempuestall the device and a separate approval igired,
for all other operating configurations, including@riable configurations with respect to 2.1093 and
different antenna configurations.

Maximum antenna gain allowed for use with this devs 2.02 dBi.

When the module is installed in the host device REC ID label must be visible through a window on
the final device or it must be visible when an asgeanel, door or cover is easily re-moved. If aot,
second label must be placed on the outside ofitlaédevice that contains the following text: “Caints
FCC ID: HFS-LI170".
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